Release Type and Definition

Server Administrator

This document contains updated information for the “Server Administrator User’s Guide” and any other technical documentation included with Server Administrator.

NOTE: System Management software, including the Server Administrator (Server Administrator), is available only on the “Systems Management Tools and Documentation” DVD.


You can access the documentation from the Systems Management Tools and Documentation DVD or from “dell.com/support/manuals”.

Version
7.4.0

Release Date
March 2014

Previous Version
7.3.0

Importance
RECOMMENDED: It is recommended to apply this update during your next scheduled update cycle. The update contains feature enhancements or changes that will help keep your system software current and compatible with other system modules (firmware, BIOS, drivers and software).

Platform(s) Affected
For a complete list of supported Dell PowerEdge systems and supported Operating systems, see the Dell Systems Software Support Matrix available in the required version of OpenManage Software at dell.com/openmanagemanuals.

What is Supported

Hardware Requirements
- Minimum of 2 GB RAM
- Minimum of 512 MB free hard drive space
- Administrator rights
- Monitor with a minimum screen resolution of 800 x 600. The recommended screen resolution is at least 1024 x 768
**Software Requirements**

- Supported operating system and web browser.
- TCP/IP connection on the managed system and the remote system to facilitate remote system management.
- Supported systems management protocol standard. For more information, see “Supported Systems Management Protocol Standards”.
- The Server Administrator Remote Access Controller service requires remote access controller (RAC) to be installed on the managed system. For more information on the software and hardware requirements, see the relevant Remote Access Controller User’s Guide.
- **NOTE:** The RAC software is installed as part of the Typical Setup installation option provided the managed system meets all of the RAC installation prerequisites.
- The Server Administrator Storage Management Service requires Server Administrator to be installed on the managed system. For more information on the software and hardware requirements, see the Server Administrator Storage Management User’s Guide.
- Microsoft Software Installer (MSI) version 3.1 or later.

**NOTE:** Server Administrator software detects the MSI version on your system. If the version is earlier than 3.1, the prerequisite checker prompts you to upgrade to MSI version 3.1. After upgrading the MSI to version 3.1, you may have to reboot the system to install other software applications such as Microsoft SQL Server.

**What’s New**

The release highlights of Server Administrator are:

- Added support for the following operating systems:
  - Microsoft Windows Server 2012 R2 Datacenter, Foundation, Essentials, and Standard editions
  - Novell SUSE Linux Enterprise Server 11 SP3 (64-bit)
  - Red Hat Enterprise Linux 6.5 (64-bit)
  - VMware ESXi 5.0 U3 and ESXi 5.1 U2
  - VMware vSphere 5.5

- Added support for the following browsers:
  - Mozilla Firefox 22 and 23
  - Internet Explorer 11
  - Safari 6.0
  - Google Chrome 27, 28, and 30

- Support for a new license format for Citrix XenServer 6.1.

- Added support for the following Adapter cards:
  - Mellanox ConnectX-3 Dual Port 40 GbE QSFP+ Network Adapter
  - Mellanox ConnectX-3 Dual Port 10 GbE DA/SFP+ Network Adapter
  - Mellanox ConnectX-3 Dual Port 10 GbE KR Blade Mezzanine Card
  - Emulex OCE14102-UX-D Dual Port 10Gb SFP+ CNA
  - Emulex OCm14102-U3-D Dual Port 10Gb KR Blade Mezz
  - Emulex OCm14102-U2-D Dual Port 10Gb KR Blade NDC
  - Emulex OCm14104-UX-D Quad Port 10Gb DA/SFP+ Rack NDC
• Support for displaying and setting the JRE version. See Secure Port System.

• Support for displaying Node Id in System/Server Module Summary information. See Server Administrator Command Line Interface Guide or online help.

• Support for new values for form factor aligning to iDRAC values. See Server Administrator Command Line Interface Guide or online help.

• Added support for Software RAID controllers (PERC S110) on systems running the Windows Server 2012 R2 operating system.

• Added support for Non-Volatile Memory Express (NVMe) Peripheral Component Interconnect Express (PCIe) solid-state drives (SSDs). See the Server Administrator Storage Management guide at dell.com/openmanagemanuals.

NOTE: Management of Dell PowerEdge Express Flash NVMe PCIe SSD devices is supported only through Dell-provided Windows Server 2012 R2 (64-bit) drivers.

• Added support for Dell PERC 9 controllers (H730P Adapter) on R920 with the following features:
  • RAID 10 virtual disk with uneven span.
  • Advanced 4KB sector hard disk drives.
  • T10 Protection Information (PI) for data integrity.

NOTE: For more information, see the Server Administrator Storage Management guide at dell.com/openmanagemanuals.

• Added support for the following LSI Serial Attached SCSI (SAS) Host Bus Adapters (HBAs) on supported 12G systems:
  • LSI SAS 9207–8e
  • LSI SAS 9300–8e
  • LSI SAS 9206–16e

• Added support for the following Dell PowerEdge servers:
  • R920
  • R220
  • M820VRTX

• Deprecated support for the following operating systems:
  • SUSE Linux Enterprise Server 10 SP4
  • SUSE Linux Enterprise Server 11 SP2
  • Red Hat Enterprise Linux 6.4 (64-bit)
  • VMware ESXi 5.1 U1 HDD and Flash
  • VMware ESXi 5.0 U2 HDD and Flash

NOTE: For the list of supported operating systems and Dell servers, see the Dell Systems Software Support Matrix in the required version of OpenManage Software at dell.com/openmanagemanuals.

NOTE: For more information about the features introduced in this release, see the Server Administrator context-sensitive online Help.
Fixes

The following problems were reported in earlier releases of Server Administrator and have been corrected in this release:

- BITS032251: OME show “The task was cancelled for the target device” with stopped execution state during OMSAPush
- BITS040212: Migrated DF489665 Max Config: OM on ESXi 4.1 U2 Experiences Timeouts and Very Poor Performance
- BITS040215: Migrated DFS29402 Battery Time to Next Learn Cycle Not Decrementing
- BITS040228: Migrated DF555351 OMSS does not send command to create DHS
- BITS049436: <OM7.1.2>License update is failing in OMSS-GUI through DWS Login
- BITS055741: Lockdown mode is enabled in ESXi 5.1 after creation of 5 Partial RAID10 VD's
- BITS057646: VD is displayed in OMSS even after deleting the same using bcdadm tool
- BITS057648: Blink/Unblink tasks are not working - physical disks are not blinking
- BITS057964: Enclosure Power status not getting updated on hotplug
- BITS059969: [Plasma-BDC-SWPT]:Watchdog Timer Expired issue observed in iDRAC LC Log, while creating partial VD's
- BITS060337: Fluid Cache node is not automatically enumerated in OMSS-GUI after reboot system on SLES OS
- BITS064366: Disk cache is enabled on SAS physical disks when creating VD's using the OMSS 7.2 advanced mode wizard
- BITS065917: Dataeng depleting kernel semaphore max after 20 or so sfcbd restarts on ESXi 5.x
- BITS069237: Device name in physical disk properties is displayed as //JCore1/Route1/Device1 instead just Device1
- BITS072405: OMSA prefs X.509 Certs pages need overhaul, online help as well
- BITS078795: om_dvd730__178_X07 (CMY20 X07-00) OMSS does not recognize all 8 of the PCIe SSD
- BITS081109: OMSA logging to linux/RHEL syslog in non-standard format
- BITS082386: om_dvd730__262X12 (CMY20 X12-00) OMSS only sees 1 of the PCIe Extenders (YPNRC A00-00)
- BITS086805: OMSA: Mismatch in mapping alerts for OMSA 7.2 Legacy and EEMI 7.2 for Power Failure alerts
- BITS087988: OMSA disallows login even when ESXi Lockdown is turned back off
- BITS089361: PCIe SSD: OMSS reports State as “Degraded” after Full Initialization of read-only device
- BITS090268: OMSA: Some of the EEMI Events are not generated
- BITS056268: <OM72-PTH>OMSA Summary has no info for storage enclosure-12G
- BITS058202: <OM72-FV>unsupported action visible on task lists of VD under SAS S/IR controller-6870
- BITS061480: DHS assigned alert - 2195 is not generated in OMSS when assigned using bcdadm.
- BITS069485: Q1FY14-H310: Vendor ID is fluctuating when there is an insertion or removal of drives.
- BITS072384: OMSA DWS must auto try port 5986, not just 443
- BITS077027: Message is not proper under TEH details while trying to install server instrumentation after cli.
• BITS083254: OMSA deploy fails on SLES10 SP4 and SLES11 system
• BITS083480: Attempt to install OMSA using MSP task pass when target does not have OMSA installed
• BITS083854: Disk Cache Policy setting in create VD via advanced wizard coming Enabled by default for SAS Drives
BITS088267: OM 7.2 displays HDD manufacture name instead of Dell immediately after startup

Important Notes

Notes for Server Administrator
On 12G systems with iDRAC7 1.30.30 and later versions, you can set the Platform Event Destination as IPv4, IPv6, or FQDN.

Notes for Instrumentation Service

• On 11G systems, if conflicting BIOS settings exist while configuring BIOS setup options through Server Administrator, the update attempt may fail at system reboot and none of the BIOS setup options may be updated.
  For example, when you configure Embedded SATA Controller to RAID and Boot Mode to UEFI simultaneously (UEFI does not support RAID option), the conflict prevents the BIOS configuration updates (at system reboot).
• On certain systems, user-defined thresholds set under Server Administrator become the default thresholds after uninstalling Server Administrator.
• If you change the threshold value of a probe on certain systems, running Server Administrator, and then uninstall Server Administrator, the changed threshold value becomes the default threshold value.
• While modifying the warning threshold settings, the values are stored in the firmware as discrete integer values and scaled for display. If the modified value is not a discrete integer, it may change when saved.
• Fan redundancy can have the following states:
  Fully Redundant - The sensors display this status if all the fans in the system are present and are in a non-failure state.
  Redundancy Lost - The sensors display this status whenever any system fan fails or is removed from the chassis.
• If a system with memory redundancy enabled enters a "redundancy lost" state, it may not be clear which memory module caused it. If you cannot determine which DIMM to replace, see the "switch to spare memory detected" log entry in the ESM system log to find the memory module that failed.
• If you run Server Administrator when the system is in "OS Install Mode", it may report the memory incorrectly. To avoid this issue, you must disable "OS Install Mode" before running the application.
• If you have to uninstall and reinstall the operating system SNMP service, then reinstall Server Administrator, so that the Server Administrator SNMP agents are registered with the operating system SNMP agent.
  Server Administrator Device Drivers for Linux: Server Administrator includes two device drivers for Linux: Systems - Management Base Driver (dcdbas) and BIOS Update Driver (dell_rbu).
• Server Administrator uses these drivers to perform the systems management functions. Depending on the system, the application loads one or both of these drivers. These drivers have been released as open source under the GNU General Public License v2.0. They are available in Linux kernels from kernel.org starting with kernel 2.6.14.
• CMC USB ports attached with blade is not enumerated by Server Administrator.

• Except for AC power cord traps, SNMP traps for server instrumentation are not generated when the state of the device sensor changes from unknown to normal. While migrating the chassis of a PowerEdge M620, M820 server running Windows operating system from M1000e to VRTX chassis, reboot the server after the new drivers are detected and installed. If not, the DSM SA Data Manager service crashes on startup and OMSA fails. (BITS125071)

Notes for Storage Management Service

• Detailed information on the Storage Management Service is available in the Storage Management Service online help. After installing and launching Server Administrator, you can access the Storage Management Service online help by selecting the Storage or lower-level tree object and clicking the Help button on the global navigation bar.

Notes for Remote Access Service

• The remote access service is available on supported systems only in this release. It enables remote access to a server that has lost its network connection or that has become unresponsive. In the current release of Server Administrator, the Remote Access Service uses Integrated Remote Access Controller (iDRAC).

• iDRAC also has its own CLI that is accessed through the “racadm” command. You can add “racadm” commands to a batch or script file to automate various user tasks. To limit the stress load on the managed system and RAC, add “sleep” or “delay” commands of one or two seconds between the individual “racadm” commands.

• On systems prior to 12G, Server Administrator slot page displays iDRAC information, but on 12G systems, the slot page does not display any iDRAC7 information.

Known Issues

This section provides information on open issues and resolutions with this release of Server Administrator.

Issues for Server Administrator running on VMware ESX Operating Systems

• DF374857: Connection service has to be restarted for an Active Directory user login. After adding a VMware ESX 4.1 operating system to the Active Directory domain, an Active Directory user must do the following:
  o To log on to Server Administrator using the VMware ESX 4.1 operating system as Server Administrator, restart the DSM SA Connection Service.
  o To log on to the Remote Node using the VMware ESX 4.1 operating system as Remote Enablement Agent, wait for about five minutes for the 'sfcbd' to add permission for the new user.

• DF354388: Remote Server Administrator Web Server connection to managed node hangs, if a redundant virtual disk containing syslog dumps fails.
  o If you configure the syslog to store logs on a remote virtual disc (VD), and remove the remote VD without reconfiguring the syslog to a valid location, the Server Administrator web server screen stops responding.
  o To continue using the Server Administrator Web server, restart the management services on the managed node.

• DF550588: On ESXi 5.0 U1 operating system, the performance of Server Administrator is slow.
  o On ESXi 5.0 U1 operating system, the Server Administrator is slow. VMware has reported this as a known issue. For more information, refer to the Knowledge Base article at - http://kb.vmware.com/kb/2016538.
• BITS072069: On ESX/ESXi Operating Systems, Server Administrator configuration changes are not persisted after an unclean shutdown.
  o If the server abruptly reboots, configuration changes to Server Administrator Preferences are not retained on VMware ESX or ESXi operating systems. Once an hour, VMware runs a scheduled backup to update any configuration changes to the installed applications (VIBs). For more information, refer to the Knowledge Base article at - [http://Kb.vmware.com/kb/2001780](http://Kb.vmware.com/kb/2001780)

• BITS119710: On systems running the VMware ESXi operating system, the TOE status of a network controller is not available.

• BITS124690: On systems running VMware ESXi 5.5 operating system, Emulex network interface cards and QLogic fibre channel cards are not supported.

Issues for Server Administrator Web Server running on all Linux Operating Systems
• DF275424 and DF332775: Domain users unable to login to Windows MN from Linux Web Server.
  o Negotiate authentication is not supported while remotely managing a Windows-based managed node from a Linux-based Server Administrator Web server. If you run the Server Administrator Web server on a Linux based operating system and try to manage a remote Windows managed system as domain user, a "login failed" message is displayed.
  o You can manage a Windows/Linux- based managed system remotely from a Windows-based Server Administrator Web server.

Issues for Server Administrator Running on All Supported Operating Systems
• BITS107804: On PowerEdge R210 II and T110 II servers, clearing the ‘Shutdown OS First’ checkbox and performing a reboot using the ‘Reboot’ option does not reboot the servers. After performing these steps if you refresh the Page, the options on the Remote Shutdown page are not displayed.

• On Dell PowerEdge T110 II systems, the following Server Administrator bios settings are not consistent with the F2 bios setup settings:
  o Watchdog timer: Server Administrator displays the option as disabled, but F2 bios allows to change the setting.
  o Embedded Video Controller: Server Administrator provides options to enable or disable, but in F2 bios the option is greyed out.
  o TPM Security: Server Administrator does not allow to change the settings, but F2 bios allows to change the settings.
  o System Profile State: Server Administrator does not allow to make changes, but F2 bios allows to make the changes.
  o Memory Testing: Server Administrator does not support this feature, but F2 bios supports this feature.
  o SRIOV option: Server Administrator does not display this information, but F2 bios displays this feature.

• Due to non-availability of resources, inventory collector may terminate unexpectedly and restart. If this occurs, the folder ‘C:\Temp\invcol” may be left as an artifact. The presence of this folder does not affect the functionality of the inventory collection. The folder can be deleted if required.

• After installing Server Administrator from the command prompt, typing an “omreport” or “mconfig” command from the same prompt can cause an error. Open a new command prompt window and type commands.

• If the command log page in the Server Administrator GUI displays an error message indicating that the XML is malformed, you must clear the command log from the CLI using the “omconfig system cmdlog action=clear” command.
After a ‘Reset to Defaults’ operation of the Integrated Remote Access Controller, the first user configuration operation fails if it is a single-user configuration item (such as enabling or disabling a user or changing user name). Always change a combination of two-user configuration items (such as enabling or disabling a user and changing user name) concurrently during your first configuration operation.

While typing the command “omreport system version -outc <filename>”, ensure that you specify an absolute path name for the output file; else, the output file is empty. For example, c:\out.txt.

Typing “omreport system esmlog/alertlog/cmdlog -fmt tbl” command on the CLI can result in XML parsing errors if the size of the log is very large. Use the GUI or the “omreport system esmlog/alertlog/cmdlog” CLI command to view the contents of the log.

For complex “omconfig” CLI commands that contain multiple set commands in one command line, the CLI may report a success status for the command even if a part of the command failed. To avoid this issue, run only one command per command line. The current settings can be confirmed by performing the corresponding ‘omreport’ command.

Some complex “omconfig” CLI commands that contain multiple set operations have been modified to avoid the above problem. While executing a CLI command if the message, “Error! Illegal combination of parameters” is displayed, modify your command into several simpler commands. Each command should change only one setting.

When running Server Administrator on a system with a traditional Chinese operating system, the application pages are displayed in simplified Chinese. To view the Server Administrator pages in English, go to your browser language preference page and change the language to English.

Log files saved from Server Administrator are saved in zip format. It is recommended that you open this zip file using WinZip. Windows Server 2003 or Windows XP embedded ‘Compressed (zipped) Folder’ utility is not recommended.

After configuring BIOS settings on certain systems, a second reboot may be required for the Server Administrator to display the updated BIOS settings properly.

If you import an invalid root certificate into Server Administrator, using “Preferences -> General Settings -> Web Server -> X.509 Certificate”, and try to log on to the application after restarting the Web server, a blank page is displayed. To fix this issue, restore your original “keystore.db” file before importing a valid root certificate. To restore the “keystore.db” file, use both the basic operating system commands and the Server Administrator Command Line Instrumentation (CLI).

Perform the following steps from your operating system command line:
  o Type: omconfig system webserver action=stop
  o Locate the “keystore.db.bak” file. The default path is “C:\program files\dell\SysMgt\apache-tomcat\conf”.
  o Copy “keystore.db.bak” to “keystore.db”.
  o Type: omconfig system webserver action=start

A temperature drop below a minimum failure threshold does not cause a system reset even if this alert action is set.

Clicking the ‘Back’ and ‘Refresh’ buttons on the browser may not display the correct page with respect to the Server Administrator component tree, tabs, tab menus, or help, as Server Administrator has been designed with limited functionality to reduce overhead. Full feature capabilities of the Web browser such as “Back”, “Refresh”, and “Open in New Window” may not be supported.

Selecting the boot sequence under the BIOS “Setup” tab does not re-enable boot devices that have been disabled in the System Setup Program, earlier.

The links on the Server Administrator home page may not work after repeated random clicking. To resolve this issue, refresh the browser by pressing <FS> or click the browser ‘Refresh’ button.
- All unsecured HTTP requests to Server Administrator receive an invalid response. Server Administrator runs only one instance of the Web server, which is secure. Make all connections through https://<ip address>:<port number>. Any "http://<ip address>:<port number>" request for connection with the server receives an invalid response.
- If the browser used with Server Administrator does not display a page or perform an action, make sure that the browser is in online mode. To go online, perform the following:
  - In Internet Explorer, on the menu bar, click "File" and clear the "Work Offline" option. When "Work Offline" is selected, a check mark is displayed to the left of the option on the "File" menu.
- If Internet Explorer prompts you to "Work Offline", "Connect", or "Try Again", always select "Connect" or "Try Again". Do not select "Work Offline".
- While setting dates in the "Asset Information" section of the Server Administrator home page, the current time is appended to the date. While setting dates with the CLI, the appended time is noon.
- On some systems, temperature probe values and settings are only supported for whole degrees, not tenths of a degree. On those systems, setting a fractional value for the minimum warning temperature threshold results in the set value being rounded off to the next whole number value. This behavior may cause the minimum warning threshold to have the same value as the minimum failure threshold.
- If you close the browser using the "Close" button on the browser or log off from the operating system, the Server Administrator session is not terminated. This session is listed in the Session Management page until the session time out occurs, or DSM SA connection service is restarted, or the operating system is rebooted.
- If you change the operating system Time Zone to a new time zone, Server Administrator session management does not display the time in the new time zone specified. Restart Server Administrator to display the accurate time for the time zone in the Session Management page.
- DF78425: The Server Administrator Auto Recovery feature may execute the configured action before the time interval when the system is under heavy stress. The Auto Recovery feature can be set to execute an action (for example, system reboot) to recover a hung system. Since the Auto Recovery timer is now an application-level timer instead of a kernel-level timer, heavy resource stress on the system may result in an inaccurate measurement of a short keep alive interval (less than 120 seconds), and the configured action may be triggered.
  - The issue is more prevalent in systems that have only one CPU with hyper-threading unsupported/disabled or systems that are subjected to persistent stressful conditions such as, resource depletion and CPU running at 100% usage with significantly more threads than normal usage.
  - The Auto Recovery feature is not enabled by default. If the Auto Recovery feature has been enabled, increase the System Reset Timer value to at least 120 seconds.
- Using the Internet Explorer browser, if you install Server Administrator on a system that includes an underscore in its hostname, you must use the IP address of the target system in the browser URL to launch Server Administrator, as Hostnames with underscores are not supported. For example, (assuming Server Administrator is listening on port 1311): https://192.168.2.3:1311.
  - For more information, see the following article on the Microsoft website http://support.microsoft.com/kb/312461
- DF 152755: The Server Administrator GUI does not respond when the alerts log has many events. If the Alert Log contains several entries and if you try to navigate to another page, the Server Administrator GUI may take about 30 seconds to display the content.
- DF 172125: Power monitoring probes are displayed on certain systems that do not support power monitoring. On certain systems that do not support power monitoring, Server
Administrator reports the two platform event filters related to power monitoring as “System Power Probe Warning” and “System Power Probe Failure”. These two filters are not supported on these systems. That is, you can view and configure these filters, but no action is taken.

- DF185770: Primary User Telephone Number does not accept symbols. On Server Administrator, under Asset Information->System Information->Primary User Telephone Number configuration allows only alphanumeric characters.
- The selection of default option for front panel LCD in Server Administrator displays the Model Name whereas the default is Service Tag on the physical LCD.
- In case Server Administrator does not respond or is locked to your selections on the component tree, perform the following steps:
  1. Click “Preferences”. The Preferences page appears.
  2. Click “Server Administrator”. The items on the front page may respond to your click.

- DF277439: Persistence of Configuration and Log File Changes in VMware ESXi On systems running the VMware ESXi operating system, the file system is ramdisk. Modifications made to the files within the file system are generally not persistent across reboots, with the exception of designated configuration and log files. These files are updated to the disk periodically and on system shutdown. If the system is reset without a graceful shutdown before the updated to the designated configuration are made and before log files are updated to the disk, the changes are lost.

  The following is an example of the effect of this behavior:
  
  - On certain systems, the first time that the thresholds for a probe are changed after Server Administrator is installed; the current threshold values for that probe are saved as the default threshold values by writing the values to a configuration file. When “Set to Default” is performed after the first change of the thresholds, Server Administrator sets the threshold values to the values that were saved in the configuration file as the default. If the system running the VMware ESXi operating system is reset without a graceful shutdown before the changes to the configuration file are updated to the disk, the user-defined thresholds become the default thresholds.

- DF315853: Some Server Administrator CLI commands functions properly only when run from the elevated console window. It is recommended that you use the elevated console for running the CLI.
- Due to some limitations, you cannot log on simultaneously to multiple browser instances/tabs using SSO login, as only one session remains active while the other sessions expire.
- DF489034: Intel TXT configuration fails due to Virtualization technology dependency
- If the current Virtualization Technology attribute setting is “Disabled” (Virtualization Technology is part of the Processor Settings group on the BIOS setup page); the Intel TXT attribute configuration fails on the Server Administrator user interface (System -> Main System Chassis -> BIOS -> Setup ->System Security.) To resolve this issue, configure Virtualization technology setting to “Enabled” and reconfigure the Intel TXT attribute, if it is configurable.
- DF549057: When an operating system is installed through USC, the BIOS attributes in Server Administrator are displayed as read-only. You can edit the BIOS attributes 18 hours after the operating system installation.

  Workaround: To enable editing of the Server Administrator BIOS attributes, launch Lifecycle Controller while booting.
- DF552204: On Mozilla Firefox browsers (versions 10, 11 and 12), Server Administrator fails to launch if IPv6 address is used.

This is a known issue. For more information, see https://bugzilla.mozilla.org/show_bug.cgi?id=633001.
• BITS04016: In case of Boot/HDD/UEFI sequence, if they are read-only, then toggle buttons (+ and -) and submit button are not visible. On BIOS setup page, dependencies may exist between the various attributes for Bios settings. Setting an attribute value may change the state of the dependent attributes to non-editable or editable. For example, changing the Boot Mode to UEFI from the Boot Settings page does not allow you to configure the Boot or Hard-Disk Drive Sequence in the BIOS Boot Settings page. When the page is non-editable, the toggle buttons on the page allows toggling the order of the boot sequence. However, settings cannot be configured since “Apply” button will not available to submit the settings.

• BITS050574: On 11G and 12G systems running the Linux OS, the omreport system summary command displays “RAC Command Interface” as 7.1.0. “RAC Command Interface” is a DRAC4 RPM and its version is 7.1. It is installed as a dependent package for iDRAC6 and iDRAC7 Command Interface packages.

• If a new certificate imported to Server Administrator is not active after restarting the Web server, restore the previous certificate.

To restore the previous certificate, do the following:

1. Stop the Web server.
2. Perform one of the following as applicable:
   On systems running Windows:
   o Delete the file keystore.db at <installed directory>\Dell\SysMgt\apachetomcat\conf\n   o Rename the file keystore.db.bak at <installed directory>\Dell\SysMgt\apachetomcat\conf\to keystore.db
   On systems running Linux:
   • For 32-bit OS
     o Delete the keystore.db file at /opt/dell/srvadmin/lib/openmanage/apachetomcat/conf
     o Rename the keystore.db.bak at /opt/dell/srvadmin/lib/openmanage/apachetomcat/conf to keystore.db
   • For 64-bit OS
     o Delete the keystore.db file at /opt/dell/srvadmin/lib64/openmanage/apachetomcat/conf
     o Rename the keystore.db.bak at /opt/dell/srvadmin/lib64/openmanage/apachetomcat/conf to keystore.db
   3. Start the Web server.

• BITS078118: On 12G systems with specific versions of iDRAC, you cannot set the platform event alert actions (reboot, shut down, and so on) through Server Administrator. Set the alert actions for the events through iDRAC GUI.

• BITS129426: On R220 systems with single CPU, Server Administrator does not display the CPU status message on CLI and GUI.

• BITS130401: On 12G systems, you cannot set the BIOS setup password from the GUI. Use the CLI to set the password.

Issues for Server Administrator Running on All Microsoft Windows Operating Systems

• Execute all Server Administrator CLI commands from a 32-bit Windows command prompt. You can access the 32-bit command prompt by clicking “Start-> Programs-> Accessories-> Command Prompt” or by clicking “Start-> Run” and then typing “cmd.exe”. Attempts to run the CLI commands from the DOS command “command.com” may generate unpredictable results.
• The DSM Server Administrator Connection Service may hang on system startup if both Oracle and VERITAS Backup Exec are installed on the system. To manually start the DSM Server Administrator Connection Service on a system running Windows, click "Start-> Programs-> Administrative Tools-> Service", right-click "DSM Server Administrator Connections Services" and select "Start".

• You may not have appropriate privileges on the Server Administrator GUI if you:
  - Belong to an Active Directory group that is part of another group.
  - Try to launch Server Administrator using the desktop icon when single sign-on is enabled.

• Broadcom architecture has a split driver implementation - evbdx.sys and bxnd60x.sys.
  - evbdx.sys is the Virtual Bus Driver (VBD); also called the Base Driver
  - bxnd60x.sys is the driver for the Broadcom NDIS device.

Microsoft Device Manager reports both the drivers, but Server Administrator displays only the driver details specific to the VBD device.

• BITS080169: Documentation for Power Supply alerts mentions only AC power supply, but the alerts are valid for both AC and DC power supplies.

• BITS054513: On a system running Windows, while running CLI commands using telnet from a system running Linux, the telnet session may terminate if the amount of data being transferred is huge.

  Workaround: Redirect the CLI output to a text file and use the “type” command to view the output

• DF551365: Server Administrator does not display the IP Address for Network Adapters that are used for virtual machines

  Description: In a Microsoft Hyper-V environment, the Server Administrator Network page may indicate network adapters that are connected to a network and display Ethernet statistics but, the IP address is displayed as ‘Unknown’. This is because Hyper-V virtualizes adapters that are bonded to its virtual switch. The Server Administrator only discovers physical network adapters and displays their IP addresses that are fully-controlled by the operating system and not by hypervisors.

• BITS080696: Windows “No Instance(s) Available” is reported for Dell_CMApplication class data. To get the data for Dell_CM* wmi classes query, first query any one of the Dell_* classes.

• BITS129139: On systems running Windows operating system, the command prompt closes if you run the following commands on any Dell PowerEdge systems:

  omconfig system platformevents event=systempowerfail action=powerreduction
  omconfig system platformevents event=systempowerwarn action=powerreduction

  Note: The commands are supported only on 9G and 10G systems.

**Issues for Server Administrator Running on Microsoft Windows 2003 Operating Systems**

• You can ignore the following warning message: A provider, omprov, has been registered in the WMI namespace, Root\CIMV2\Dell, to use the LocalSystem account. This account is privileged and the provider may cause a security violation if it does not impersonate user requests correctly. This can be ignored as the Managed Object Format file used to register the provider ("omprov") states that the provider only reads the inventory data; it does not perform any functions on the server that require user impersonation.

• When running Server Administrator, crypt32.dll errors may be written to the operating system Application Event log. This issue occurs due to the “Update Root Certificates” component, which is installed by default as part of Windows Server 2003 installation. For more information on this component and reasons for errors, see the following articles on the Microsoft website:
There are two options to avoid these errors from being written to the Event log:

- Uninstall the "Update Root certificates" component as described in the first knowledge base article mentioned above. **NOTE:** This procedure may affect other programs as discussed in the article.
- Install the Server Administrator certificate as a trusted certificate. **NOTE:** This procedure may still prompt you to accept the certificate when you log in to Server Administrator, but will prevent the crypt32 errors from being logged to the Event log.

**Issues for Server Administrator running on Microsoft Windows 2008 Operating Systems**

- **DF94201:** Single sign-on may not work if Server Administrator is launched using the desktop icon.

  If Server Administrator is launched using the desktop icon, Single Sign-on may not work if in the Internet Explorer, under "Tools" -> "Internet Options" -> "Security" -> "Custom Level", the "User Authentication Logon" option is set to "Prompt for user name and password".

  To resolve this issue, perform the following:

  1. Find and select "Tools" from the menu.
  2. Select "Internet Options" and click the "Security" tab.
  3. Click "Custom level" button and scroll down to "User Authentication".
  4. Under "Logon", choose the option "Automatic logon with current user name and password". If Server Administrator is running in the "Local Intranet Zone", you may choose the option "Automatic log on only in Intranet zone" instead.
  5. Click "Ok" to open dialog boxes to complete the setting.

- **DF103661:** Microsoft Windows Server 2008 - Alert Action -> Execute Application

  For security reasons, Microsoft Windows Server 2008 is configured to not to allow interactive services. When a service is installed as an interactive service on Microsoft Windows Server 2008, the operating system logs an error message in the Windows System log about the service being marked as an interactive service. When you use Server Administrator to configure Alert Actions for an event, you can specify the action to "execute an application". For interactive applications to be executed properly for an Alert Action, the DSM Server Administrator Data Manager Service must be configured as an interactive service. Examples of interactive applications comprise applications with a Graphical User Interface (GUI) or that prompt users for input in some way such as the "pause" command in a batch file.

  When Server Administrator is installed on Microsoft Windows Server 2008, the DSM Server Administrator Data Manager Service is installed as a non-interactive service, which means that it is configured for not interacting with the desktop directly. If an interactive application is executed for an Alert Action in this situation, the application is suspended awaiting input from the user, but the application interface or prompt is not visible to the user. The application interface or prompt is not visible even after the Interactive Services Detection service is started. For each execution of the interactive application, there is an entry for the application process in the "Processes" tab in Task Manager.

  If you want to execute an interactive application for an Alert Action on Microsoft Windows Server 2008, you must configure the DSM Server Administrator Data Manager Service to be allowed to interact with the desktop. To allow interaction with the desktop, right-click on the DSM Server Administrator Data Manager Service in the Services control panel and select Properties. In the "Log On" tab, enable "Allow service to interact with desktop" and click OK.

  Restart the DSM Server Administrator Data Manager Service for the change to be effective. When the DSM Server Administrator Data Manager Service is restarted with this change,
the Service Control Manager logs the following message to the System log: “The DSM Server Administrator Data Manager Service is marked as an interactive service. However, the system is configured to not allow interactive services. This service may not function properly.” This change allows the DSM Server Administrator Data Manager Service to execute interactive applications properly for an Alert Action. Also, make sure the Interactive Services Detection service is running, to see the interface or prompt displayed by the interactive application. Once these changes are made, the operating system displays the “Interactive services dialog detection” dialog box to provide access to the interactive application interface or prompt. After upgrading Windows Server 2003 x64 to Windows Server 2008 x64 with Server Administrator installed, the application UI does not display all the expected instrumentation pages. The Server Administrator installation must be repaired.

Go to Start -> Settings -> Control panel -> Add Remove Programs -> Select ‘Change’ on the Server Administrator installation and select the “Repair” option to correct the issue.

- DF330800: Server Administrator Web server local user login fails on the Windows 2008 R2 Managed Node. When a Windows 2008 R2 Managed Node is added to a domain, logging in from any Server Administrator Web Server to that Windows 2008 R2 Managed Node will fail with local user or local power-user credentials. Only the credentials of a local Administrator or Domain user will work, with a prerequisite that all required winrm configurations have been applied.

**Issues for Server Administrator running on Microsoft Windows 2012 Operating Systems**

- BITS068231: On Windows Server 2012 with Server Administrator (32-bit), “Base Memory Address” and IRQ values are not available for any Network Interface Cards.

**Issues for Server Administrator running on Red Hat Enterprise Linux Operating Systems**

- When starting Server Administrator from the Red Hat Enterprise Linux console, kernel log messages may appear. To avoid these messages, perform the following steps:
  - Edit the `/etc/sysconfig/syslog` file and modify `KLOGD_OPTIONS` to `KLOGD_OPTIONS="-c 4"`.
  - Restart `syslog` by executing `/etc/init.d/syslog restart`.
- When using the Mozilla browser on Red Hat Enterprise Linux operating systems, the font and type size on the Server Administrator global navigation bar appear different from the default font and type size that the application uses.
- For systems running a supported Red Hat Enterprise Linux operating system, kernel driver messages such as ‘AAC_ChardevOpen’ may be displayed in the console at the login prompt. These messages are displayed in the console when the driver initialization is delayed by the installation of Server Administrator services and can be ignored.
- BITS110353: On servers installed on FX2 series chassis Server Administrator Home page does not load on Red Hat Enterprise Linux 6.5 operating system.

**Issues for Remote Access**

NOTE: The Remote Access Service is supported on 11G systems only.

The following subsections list the currently known issues regarding implementation and operation of your RAC and the Remote Access Service in Server Administrator.

**Issues for all Operating Systems**

- Server Administrator user interface and commands related to “local authentication enable” are not applicable for RAC firmware 3.20. The Active Directory authentication feature replaces the “local operating system authentication” feature in this version of firmware. Due to this change, the following commands return errors:
  - racadm localauthenable
omconfig rac authentication

- Due to fluctuations in the watchdog timer, the “Last Crash Screen” may not be captured when the Automatic System Recovery is set to a value of less than 30 seconds. To ensure correct functioning of the “Last Crash Screen” feature, set the System Reset Timer to at least 30 seconds.

- DF132894: The cfgDNSServer1 and cfgDNSServer2 properties of group cfgLanNetworking may be set to identical values while swapping addresses. Some performance may be lost temporarily during the swapping. The cfgLanNetworking group is configured using the “racadm config” command.

- The remote access controller uses FTP protocol to perform some of the Server Administrator commands. If a firewall is installed in the system, it may cause these commands to fail.

The following Server Administrator CLI commands use FTP protocol to communicate with the RAC:

- “omconfig rac uploadcert”
- “omconfig rac generatecert”

The following racadm commands use FTP protocol to communicate with the RAC:

- “racadm sslcertupload”
- “racadm sslcsrgen”
- “racadm fwupdate”

- If the RAC configuration is reset to factory defaults using the “racadm racresetcfg” command, the RAC configuration tab in Server Administrator does not reflect the reset configuration settings until the system reboots. Also, the RAC configuration page in Server Administrator cannot be used to make any configuration changes until the system reboots.

- The RAC does not support local RAC user IDs with special characters. When adding a local RAC user, use only alphanumeric characters for the user name.

- While the RAC is being reset, the Instrumentation Service cannot read sensor data for certain systems. As a result, the voltage, temperature, and other probes may not be visible on the Server Administrator home page until the RAC has completed resetting.

- The RAC may not send traps when your system is locked up. To enable traps to be sent when the system is locked, configure the watchdog timer using the Server Administrator GUI. On the GUI, click the “Properties” tab and ensure that “Auto Recovery” is selected. The default value of the “Action On Hung Operating System Detection” setting is “None”. “None” indicates that detection will not be performed.

- RAC firmware 2.0 and later does not support passwords with special characters (non-alphanumeric) only for RAC user IDs logging in using the Web-based interface (with Local RAC Authentication). You cannot log on to RAC, if you created RAC user IDs using previous versions of the firmware or using Server Administrator that is running version 2.0 firmware on the managed system.

Use one of these methods to correct this issue:

- Change your passwords before updating the firmware.
- Use the following CLI command to change the password: “omconfig rac users username=xx userpassword=yy” where ‘xx’ is the original user ID and ‘yy’ is the new password.
- Change the password through Server Administrator using the “User” tab. Make sure that the check box to change the password is checked. Enter a new password, and then enter it again to validate the change.
- Use the racadm utility to change the password:
  `racadm config -g cfgUserAdmin -o cfgUserAdminPassword`
where `<usr_index>` is the index of the user database entry to be modified and `<new_pwd>` is the new password.

- Depending on your network and proxy configurations and whether you are using Mozilla browser, you may need to enter the exact IP address of the RAC controller you are trying to access in the "No Proxy for" field of your browser.

Perform the following steps:

1. Open your Mozilla browser.
2. Click "Edit".
3. Click "Preferences".
4. Click "Advanced" in the left sidebar.
5. Click "Proxies" in the left sidebar.
6. Enter the RAC IP address in the "No Proxy for:" field.
7. Click "OK" and then close the browser.

- If the out-of-band RAC user interface is spawned off from the Server Administrator home page with a Mozilla browser, strings with extended ASCII characters may not display correctly in certain languages. This issue occurs because the Server Administrator sets the browser UTF-8 character. To correct this issue, change the browser character coding to ISO-8859-1. For Japanese and Chinese, UTF-8 is the correct encoding for RAC pages.

- To view the RAC Web-based interface when using Mozilla 1.6, you must configure your cookie settings to "Enable all cookies".

- To enable all cookies, go to the menu options and click "Edit -> Preferences -> Privacy & Security -> Cookies", and then select "Enable all cookies". If you do not perform these steps, you cannot log on to the Web interface and a message appears indicating that your username and password are incorrect.

- DF384362: "Redundancy Status" displays as "Not Applicable" in ESXi even when NICs are teamed. On VMware ESXi systems, NIC teaming status may not display up in the Server Administrator network section. This is an expected behavior due to operating system limitation and has no functional impact to the system.

- DF384061: Self-signed certificate does not enable the compatibility listener in Windows 2008 R2 managed node. On a Windows 2008 R2 managed node, a valid CA signed certificate is required to create compatibility mode WinRM Listener. You cannot create a compatibility mode listener with a self-signed certificate.

- DF165588: Blank page is displayed after the browser is refreshed using <FS> or by clicking the browser "Refresh" button.

- Server Administrator UI may display a blank page after the browser is refreshed, using <FS> or by clicking the browser "Refresh" button in Internet Explorer Version 7.0. This is a known issue and Microsoft has provided an article and fix. The Knowledge Base article number is KB933006 and the fix is provided as security update 933566 (MS07-033): Cumulative Security Update for Internet Explorer.

- DF319132: Set operation in Server Administrator is blocked if a single sign-on is used to log on. Internet Explorer 8 has a new security feature called "Loopback security check" which prevents NTLM-based authentication from the local machine. This feature blocks users from performing any set operation in Server Administrator if they are logged in using single sign-on (SSO), (clicking the Server Administrator desktop icon) on Internet Explorer 8.

- DF380725: On Internet Explorer or Firefox Web browsers, you cannot attach files to an e-mail if the filename contains non-ASCII letters. To attach files to an e-mail, rename files to contain ASCII characters.

- On 12G servers, Server Administrator displays the Embedded Systems Management (ESM) or hardware logs. However, when the maximum limit for number of logs that can be
recorded is reached, the existing oldest logs are overwritten. But for 11G servers or below, when the maximum limit is reached, the information logging is stopped.

- DF523827: On Citrix XenServer 6.0, if the Alert on Console alert action is configured from the Server Administrator CLI or GUI, the alert message may not be displayed in a readable format.
- DF530134: On VMware ESX 4.1 managed node, while USB arbitration service is running, Inventory Collector does not respond while stopping the Server Administrator services.
- BITS099660: Server Administrator 4D4JN X00-00 remote node management does not report LPe16002 #4V0JT cards in slots 3 and 4.
- BITS112307: Server Administrator 7.4 does not consistently display DIMM failure status.
- BITS113585: Server Administrator does not log CPU or CMOS Battery Probe Alerts and does not send SNMP traps.
- BITS116474: On systems running XenServer 6.1 operating system remote shutdown of operating system does not work properly, if you clear the Shutdown OS first option.
- BITS119516: DWS login fails on ESXi 5.5 with the latest SVN_704 build.

To resolve this issue, stop the USB arbitration service and run the Inventory Collector.

To stop the USB arbitration service:

1. Run the ‘ps aux|grep usb’ command to check if the USB arbitration service is running.
2. Run the ‘chkconfig usbarbitrator off’ command to prevent the USB arbitration service from starting during boot.
3. After the USB arbitration service is stopped, reboot the server to allow the Inventory collector to run.

- DF531509: The setup and/or system password configuration from Server Administrator GUI or CLI is successful, but the password is displayed as blank instead of asterisk (*) on the F2 BIOS page.
- DF532055: From Windows Server 2008 R2 SP1, when an administrator manages Red Hat Enterprise Linux 6.1 (64-bit) or 5.7 (32 and 64-bit) operating systems, Server Administrator reports connection error intermittently.

Workaround: Perform the following and manage the remote system from webserver.

1. Configure TCP Chimney offload to disable state by running following command:
   netsh int tcp set global chimney=disabled
2. Configure RSS (Receive Side Scaling) to disable state by running following command:
   netsh int tcp set global rss=disabled
3. Configure NetDMA to disable state by running following command:
   `netsh int tcp set global NetDMA=disabled`

**Limitations**

**Known Limitations and Workarounds for Storage Management Service**

- With Chinese or Japanese language browser settings, using the Storage Management Service Advanced Create VDisk Wizard may occasionally result in text overflowing to the bottom of the side-by-side blue text boxes.
- View slot occupancy report shows 4 HDD slots on backplanes with just two HDD slots for any server.
- Physical disk clear operation is not available on PERC 8 family of controllers.
- Physical disk properties such as Manufacture day, Manufacture week, and Manufacture year are available for SAS drives only.
- Creating many sliced span virtual disks using the spun-down drives through the command line or GUI result may be delayed.

  **Workaround:** After creating one sliced span virtual disk, wait for some time to create the next sliced span virtual disk.
- In ESX4 Classic, `deprecated SCSI ioctl` message is displayed on the console.

  **Description:** In VMware ESX 4.0 Classic system, the following warning message(s) is displayed on the console: “Program dsm_sa_datamgrd is using the deprecated SCSI ioctl, Please convert it to SG_IO.” This is a kernel warning message displayed when storage operations are in progress. This is only a deprecation warning and not an indication of a failing operation.

  **Workaround:** Reduce the kernel logging level. By default, VMware ESX kernel logging level is set to ‘6’ to print all the kernel messages with severity higher than ‘information.’ Reduce it to ‘4’, so that messages with severity, ‘error,’ and above get printed to the console.

  To do this, execute the following command as a ‘root’ user:
  `/proc/sys/kernel/printk`

- A Security Key Identifier can contain numerals, lowercase alphabets, uppercase alphabets, non-alphanumeric characters (except space), or a combination of any of these.

  **NOTE:** If you have used the special characters ‘/’ (forward slash) or ‘ ’ (single quote) in the Security Key Identifier, they are displayed as ‘_’ (underscore) on the Change Security Key page and Import Secured Foreign Configurations page. This is applicable only to the Security Key Identifier and not to the Passphrase.

- If Storage Management displays a path failure message for a Logical Connector after a reboot, use the “Clear Redundant Path View”, provided in the “Change Controller Properties” controller task, and restart the system.

  **NOTE:** Use this command only if you have intentionally removed the multipath connection while rebooting the system.

- In the VMware ESX 4.x and ESX 5.x environment, when you create a virtual disk using Storage Management, you may see an error message “The task failed to complete: The create virtual disk task was successful but the operating system may not be aware of the new virtual disk.” However, the virtual disk is available for all operations on rebooting the system.

- Patrol Read is not supported on SSD media. The Patrol Read feature fails for any controller that has SSD media on a virtual disk.
• Hot plug of enclosures takes time to enumerate the enclosure and its components. During this time, there will be a delay in the response time of tasks, such as displaying the physical disks on the physical disk page and in the virtual disk selection page.

• All virtual disks from the SAS/iR controller display the name “IR Virtual Disk” on the “Preview” page. On successful import, another name is assigned to these virtual disks and the “IR Virtual Disk” name is not displayed on the “Preview” page.

• Storage Management does not permit connecting the first enclosure in single path and attaching the subsequent enclosures in multipath. All enclosures must be connected in multipath to enable the multipath view.

• An error message may not appear when “Import Foreign Configuration” task is not successful.
  Description: The “Import Foreign Configuration” task can only import virtual disks that have consistent data. A virtual disk with inconsistent data cannot be imported. When importing multiple virtual disks in a single operation, however, the “Import Foreign Configuration” task may report successful completion even when inconsistent virtual disks are present and have not been imported successfully.
  Solution: If the “Import Foreign Configuration” task is unable to import an inconsistent virtual disk, then the physical disks that belong to the virtual disk continue to display a “Foreign” state after the “Import Foreign Configuration” task completes. In this case, repeat the “Import Foreign Configuration” task until one of the following occurs:
    o There are no longer any physical disks in “Foreign” state after the “Import Foreign Configuration” task completes.
    o You receive an error stating that the “Import Foreign Configuration” task has not completed successfully. This error indicates that there are no longer any consistent virtual disks available to be imported. Therefore, all virtual disks that are not imported are inconsistent and you can either perform a “Clear Foreign Configuration” to remove the virtual disks or remove the physical disks from the controller.

• DF60696: Storage Management responds slowly when using Internet Explorer 7.x, 8.x on a system with mixed SAS and SATA physical disks.
  Description: When using the ‘Create Virtual Disk’ wizard from the Storage Management graphical user interface (GUI), you may notice decreased performance when using Internet Explorer 7.x, 8.x on a system with multiple PowerVault MD1000 storage enclosures that are heavily populated with mixed SAS and SATA physical disks.
  Solution: Use a supported browser other than Internet Explorer 7.x, 8.x or use the Storage Management command line interface (CLI) to create the virtual disk. See the Server Administrator readme for information on supported browsers. See the Storage Management online help or the “Server Administrator Command Line Interface User’s Guide” for information on using the Storage Management CLI.

• DF152362: Storage Management may not display controllers installed with the Service and Diagnostics utility.
  Description: Storage Management may not recognize devices that are installed after Storage Management is already running.
  Solution: If Storage Management does not recognize a newly-added device and this problem has not been corrected with a Global Rescan, then reboot the system.

• DF120475: Storage Management SNMP traps are not filtered by Server Administrator.
  Description: Server Administrator allows you to filter SNMP traps that you do not want to receive. To implement SNMP trap filtering, select the “System” tree-> “Alert Management” tab-> “SNMP Traps” subtab. The “SNMP Traps” subtab has options for enabling and disabling SNMP traps based on severity or the component that generates the trap. Even when the SNMP traps are disabled, Storage Management generates SNMP traps.
  Solution: SNMP trap filtering will be provided in a future release of Storage Management.
When issuing certain "omconfig storage" CLI commands with "Power User" privileges, the "Error! User has insufficient privileges to run command: omconfig" message may be displayed. You must be logged on as an Administrator to perform these actions.

Using the Storage Management Service "Advanced Create VDisk Wizard" may occasionally result in a vertical scrollbar of less than normal width. If this occurs, resizing the Server Administrator window causes the vertical scrollbar to be redrawn correctly.

Using the GUI, if a virtual disk is renamed to a name containing multiple blank and consecutive spaces, the name is truncated to a single space after "Apply" is clicked.

Fluid Cache Details are not automatically enumerated on SUSE Linux 11 SP2 x86_64 operating system after system reboot.

Description: Fluid Cache details are not enumerated in CLI or GUI after system reboot. Issue is applicable only to SUSE Linux 11 SP2 x86_64 operating system.

Solution: To see the Fluid Cache details through CLI or GUI, connect to Fluid cache through CLI or GUI.

- CLI Command to connect to Fluid Cache: omconfig storage fluid cache action=connect
- GUI Command to connect to Fluid Cache: Although Fluid Cache details are not enumerated in GUI after system reboot, Fluid Cache component is enumerated in Storage component tree.

Steps to connect:
1. Click on Fluid Cache component listed under storage tree.
2. Click on "Connect Fluid Cache" option to connect to Fluid Cache.

BITS118226: The representation of NVMe devices residing on backplanes that attach to PCIe Extender cards is inaccurate on Storage Management. This is because Storage Management does not have a process to understand the mapping of the NVMe device, backplane, and the PCIe Extender card. This issue exists only on PowerEdge R920 servers and does not impact the operations on the NVMe device. Multiple backplanes on Server Administrator indicates the presence of multiple PCIe Extender cards on the system.

BITS124349: Firmware version for SAS 9207_8e, SAS 9206_16e, and SAS 9300_8e, will not be displayed on Storage Management GUI and CLI.

BITS123999: SAS 9300_8e is not supported on systems running the VMware ESXi operating system.

BITS128355: The slot occupancy report displays single backplane ID and backplane name in GUI & CLI.

The physical disk slot occupancy report for PCIe Subsystem displays NVMe devices present in two different PCIe backplanes under the same PCIe backplane on PowerEdge R920 servers. The NVMe devices connected to different PCIe backplanes are displayed correctly under Storage --> PCIe-SSD Subsystem --> PCIe-SSD Extender --> Enclosure.

BITS128540: The firmware version of the storage controller is not present under Storage --> Controller --> Firmware/Driver Version. The information is displayed under Storage --> Controller --> Information/Configuration.

Installation Prerequisites

Storage Management does not display controllers and their features on systems that do not meet the driver and firmware requirements. At Storage Management runtime, you can determine whether the
system meets the firmware requirement or not, by checking the application log files for notifications on outdated firmware. At runtime, On SCSI controllers, Storage Management displays the firmware version at runtime while on SAS controllers it displays the firmware and driver versions.

**Installation Procedure**

For complete installation instructions, see the "Server Administrator Installation Guide".

This section provides information to enhance your experience with Server Administrator implementations and environments.

- To install Server Administrator on Windows Server 2008 R2 SP1 Core and Windows Server 2012 Core, Windows-on-Windows (WOW) mode must be enabled.
- Port 1311 is the default port for Server Administrator. It is a registered port number of Server Administrator. If another application is configured to run on port 1311 before Server Administrator is installed, the DSM SA Connection Service does not start after installation. Before you install Server Administrator, make sure that the port 1311 is not in use.
- Before starting Server Administrator, you must enable the client-side scripting in Internet Explorer. To do so, perform the following:
  1. In Internet Explorer, navigate to the “Tools” menu.
  2. Click “Internet Options”.
  3. Click the “Security” tab.
  4. Select the security zone to which the system running Server Administrator belongs. NOTE: This option should be set to “Trusted sites”.
  5. Click the “Custom Level” button.
  6. For Windows 2003, perform the following:
     - In “Miscellaneous”, select the “Allow META REFRESH” radio button.
     - In “Active Scripting”, select the “Enable” radio button.
     - Under “Active scripting”, select the “Allow scripting of Microsoft web browser controls” radio button.
  7. Click ‘OK’ and restart your browser.

To allow Single Sign-on for Server Administrator, perform the following steps:
  1. In Internet Explorer, navigate to “Tools”.
  2. Click “Internet Options”.
  3. Click the “Security” tab.
  4. Select “Trusted sites”.
  5. Click the “Custom Level” button.
  6. Under “User Authentication”, select the “Automatic Logon with current username and password” radio button. Click ‘OK’ to exit the “Custom Level” window.
  7. Select the “Advanced” tab and in “HTTP 1.1 settings”, make sure “Use HTTP 1.1” is checked.
  8. Select “Trusted sites”. Click ‘Sites’. Add the server to the website.
  9. Click “Close”.
  10. Click ‘OK’ and restart your browser.

If you run a security scanner tool such as Nessus, against the Server Administrator Web server, security warnings may be displayed against port 1311, the port running the Server Administrator Web server. The warnings have been investigated by engineering and are determined to be “false positives” (invalid security warnings) that you can ignore. The following are the warnings:
• “The Web server on 1311 allows scripts to read sensitive configuration and / or XML files.”
• “The Web server on 1311 allows to delete ‘/’ which implies that the Webserver will allow a remote user to delete the files in root on the server.”
• “The web server on 1311 may be susceptible to a ‘www Infinite Request’ attack.”
• “It is possible to make the remote thttpd server execute arbitrary code by sending a request like: GET If-Modified-Since:AAA[...AAAA
  Solution: If you are using thttpd, upgrade to version 2.0. Else, contact the vendor for a patch or change the web server. CVE on this one is CAN-2000-0359”.

Enabling Integrated Windows Authentication in Internet Explorer is not required to activate the Single Sign-On feature.

The Server Administrator security settings are not applicable for Active Directory users. Active Directory users with read-only login can access Server Administrator, even if the access is blocked in the Server Administrator Preferences page.

Dell SNMP MIB Files for Dell Systems:

Dell SNMP MIB files for Dell systems allow you to obtain and verify information provided by supported software agents. The current MIB files supported by PowerEdge software agents are located at “\support\mib” on the “Systems Management Tools and Documentation” DVD.

NOTE: A MIB-II-compliant, SNMP-supported network management station is required to compile and browse MIB files.

OpenManage support for Encrypting File System (EFS)

To improve security, Microsoft allows encrypting files using EFS. Note that SERVER ADMINISTRATOR will not function if its dependent files are encrypted.

Server Administrator GUI and CLI Response Time

On PowerEdge 9G and later systems, the response time for some components of the Server Administrator GUI and CLI has increased to several seconds as Server Administrator does not cache some of the DRAC/iDRAC data. The data is retrieved from the DRAC/iDRAC when you request for it.

Following are the Server Administrator GUI pages for which the response time may have increased:
  o Server Administrator home page on log in
  o Remote Access -> Users
  o Alert Management -> Platform Events

Following are the Server Administrator CLI commands for which the response time may have increased:
  o omreport chassis remoteaccess config=user
  o omreport system platformevents
  o omreport system pedestinations

The amount of time varies depending on the hardware and operating system.

Firmware for PERC controllers

<table>
<thead>
<tr>
<th>Controller</th>
<th>Firmware/BIOS</th>
</tr>
</thead>
<tbody>
<tr>
<td>PERC 5/E</td>
<td>5.2.2-0076</td>
</tr>
<tr>
<td>PERC 5/i Integrated</td>
<td>5.2.3-0074</td>
</tr>
<tr>
<td>PERC 5/i Adapter</td>
<td>5.2.3-0074</td>
</tr>
<tr>
<td>SAS 5/iR Integrated</td>
<td>00.10.51.00/ 06.12.05.00</td>
</tr>
<tr>
<td>SAS 5/iR Adapter</td>
<td>00.10.51.00/ 06.12.05.00</td>
</tr>
<tr>
<td>SAS 5/i Integrated</td>
<td>00.10.51.00/ 06.12.05.00</td>
</tr>
<tr>
<td>SAS 5/E Adapter</td>
<td>00.10.51.00/ 06.12.05.00</td>
</tr>
<tr>
<td>PERC 6/E Adapter</td>
<td>6.3.1-0003</td>
</tr>
<tr>
<td>PERC 6/i Integrated</td>
<td>6.3.1-0003</td>
</tr>
<tr>
<td>PERC 6/i Adapter</td>
<td>6.3.1-0003</td>
</tr>
<tr>
<td>SAS 6/iR Integrated</td>
<td>00.25.47.00</td>
</tr>
<tr>
<td></td>
<td>06.22.03.00</td>
</tr>
<tr>
<td>SAS 6/iR Adapter</td>
<td>00.25.47.00</td>
</tr>
<tr>
<td></td>
<td>06.22.03.00</td>
</tr>
<tr>
<td>SAS 6/int. Modular</td>
<td>00.25.47.00</td>
</tr>
<tr>
<td></td>
<td>06.22.03.00</td>
</tr>
<tr>
<td>PERC H800 Adapter</td>
<td>12.10.5-0001</td>
</tr>
<tr>
<td>PERC H700 Integrated</td>
<td>12.10.5-0001</td>
</tr>
<tr>
<td>PERC H700 Adapter</td>
<td>12.10.5-0001</td>
</tr>
<tr>
<td>PERC H700 Modular</td>
<td>12.10.5-0001</td>
</tr>
<tr>
<td>PERC H200 Adapter</td>
<td>07.03.06.00</td>
</tr>
<tr>
<td>PERC H200 Integrated</td>
<td>07.03.06.00</td>
</tr>
<tr>
<td>PERC H200 Modular</td>
<td>07.03.06.00</td>
</tr>
<tr>
<td>PERC H200 Embedded</td>
<td>07.03.06.00</td>
</tr>
<tr>
<td>6Gbps SAS HBA</td>
<td>07.03.06.00</td>
</tr>
<tr>
<td>Internal Tape Adapter</td>
<td>07.03.06.00</td>
</tr>
<tr>
<td>PERC H310 Adapter</td>
<td>20.12.0-0004</td>
</tr>
<tr>
<td>PERC H310 Mini Monolithic</td>
<td>20.12.0-0004</td>
</tr>
<tr>
<td>PERC H310 Mini Blades</td>
<td>20.12.0-0004</td>
</tr>
<tr>
<td>PERC H710 Adapter</td>
<td>21.2.0-0007</td>
</tr>
<tr>
<td>PERC H710 Mini Blades</td>
<td>21.2.0-0007</td>
</tr>
<tr>
<td>PERC H710 Mini Monolithic</td>
<td>21.2.0-0007</td>
</tr>
<tr>
<td>PERC H710P Adapter</td>
<td>21.2.0-0007</td>
</tr>
<tr>
<td>PERC H710P Mini Blades</td>
<td>21.2.0-0007</td>
</tr>
<tr>
<td>PERC H710P Mini Monolithic</td>
<td>21.2.0-0007</td>
</tr>
<tr>
<td>PERC H810 Adapter</td>
<td>21.2.0-0007</td>
</tr>
<tr>
<td>PERC S110</td>
<td>3.0.0.0139</td>
</tr>
<tr>
<td>PERC S100</td>
<td>2.0.0-0162</td>
</tr>
<tr>
<td>PERC S300</td>
<td>2.0.0-0166+00193000</td>
</tr>
<tr>
<td>PERC H730P Adaptor</td>
<td>25.2.0-0016</td>
</tr>
<tr>
<td>PERC H730P Mini Blades</td>
<td>25.2.0-0016</td>
</tr>
<tr>
<td>PERC H730P Mini</td>
<td>25.2.0-0016</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>PERC 5/E</td>
<td>2.24.0.32</td>
</tr>
<tr>
<td>PERC 5/i Integrated</td>
<td>2.24.0.32</td>
</tr>
<tr>
<td>PERC 5/i Adapter</td>
<td>2.24.0.32</td>
</tr>
<tr>
<td>SAS 5/iR Integrated</td>
<td>1.28.03.01</td>
</tr>
<tr>
<td>SAS 5/iR Adapter</td>
<td>1.28.03.01</td>
</tr>
<tr>
<td>SAS 5/i Integrated</td>
<td>1.28.03.01</td>
</tr>
<tr>
<td>SAS 5/E Adapter</td>
<td>1.28.03.01</td>
</tr>
<tr>
<td>PERC 6/E Adapter</td>
<td>2.24.0.32</td>
</tr>
<tr>
<td>PERC 6/i Integrated</td>
<td>2.24.0.32</td>
</tr>
<tr>
<td>PERC 6/i Adapter</td>
<td>2.24.0.32</td>
</tr>
<tr>
<td>SAS 6/iR Integrated</td>
<td>1.28.03.01</td>
</tr>
<tr>
<td>SAS 6/iR Adapter</td>
<td>1.28.03.01</td>
</tr>
<tr>
<td>SAS 6/iR Modular</td>
<td>1.28.03.01</td>
</tr>
<tr>
<td>LSI 1020 on a PowerEdge 1600SC</td>
<td>Not Applicable</td>
</tr>
</tbody>
</table>

**Windows Drivers for PERC Controllers**

<table>
<thead>
<tr>
<th>LSI 1030 on a PowerEdge 1750</th>
<th>Not Applicable</th>
<th>Not Applicable</th>
<th>Not Applicable</th>
<th>Not Applicable</th>
</tr>
</thead>
<tbody>
<tr>
<td>PERC H800 Adapter</td>
<td>4.31.1.32</td>
<td>4.31.1.64</td>
<td>4.31.1.64</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H700 Integrated</td>
<td>4.31.1.32</td>
<td>4.31.1.64</td>
<td>4.31.1.64</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H700 Adapter</td>
<td>4.31.1.32</td>
<td>4.31.1.64</td>
<td>4.31.1.64</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H700 Modular</td>
<td>4.31.1.32</td>
<td>4.31.1.64</td>
<td>4.31.1.64</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H200 Adapter</td>
<td>2.0.35.10</td>
<td>2.0.35.10</td>
<td>2.0.35.10</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H200 Integrated</td>
<td>2.0.35.10</td>
<td>2.0.35.10</td>
<td>2.0.35.10</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H200 Modular</td>
<td>2.0.35.10</td>
<td>2.0.35.10</td>
<td>2.0.35.10</td>
<td>Native</td>
</tr>
<tr>
<td>6Gbps SAS HBA</td>
<td>2.0.35.10</td>
<td>2.0.35.10</td>
<td>2.0.35.10</td>
<td>Native</td>
</tr>
<tr>
<td>PERC H310 Adapter</td>
<td>5.1.118.32</td>
<td>5.1.118.64</td>
<td>5.1.118.64</td>
<td>5.1.118.64</td>
</tr>
<tr>
<td>PERC H310 Mini Monolithic</td>
<td>5.1.118.32</td>
<td>5.1.118.64</td>
<td>5.1.118.64</td>
<td>5.1.118.64</td>
</tr>
<tr>
<td>PERC H310 Mini Blades</td>
<td>5.1.118.32</td>
<td>5.1.118.64</td>
<td>5.1.118.64</td>
<td>5.1.118.64</td>
</tr>
<tr>
<td>PERC H710 Adapter</td>
<td>5.1.118.32</td>
<td>5.1.118.64</td>
<td>5.1.118.64</td>
<td>5.1.118.64</td>
</tr>
<tr>
<td>PERC H710 Mini Blades</td>
<td>5.1.118.32</td>
<td>5.1.118.64</td>
<td>5.1.118.64</td>
<td>5.1.118.64</td>
</tr>
<tr>
<td>PERC H710 Mini Monolithic</td>
<td>5.1.118.32</td>
<td>5.1.118.64</td>
<td>5.1.118.64</td>
<td>5.1.118.64</td>
</tr>
<tr>
<td>PERC H710P Adapter</td>
<td>5.1.118.32</td>
<td>5.1.118.64</td>
<td>5.1.118.64</td>
<td>5.1.118.64</td>
</tr>
<tr>
<td>PERC H710P Mini Blades</td>
<td>5.1.118.32</td>
<td>5.1.118.64</td>
<td>5.1.118.64</td>
<td>5.1.118.64</td>
</tr>
<tr>
<td>PERC H710P Mini Monolithic</td>
<td>5.1.118.32</td>
<td>5.1.118.64</td>
<td>5.1.118.64</td>
<td>5.1.118.64</td>
</tr>
<tr>
<td>PERC H810 Adapter</td>
<td>5.1.118.32</td>
<td>5.1.118.64</td>
<td>5.1.118.64</td>
<td>5.1.118.64</td>
</tr>
<tr>
<td>Internal Tape Adapter</td>
<td>2.0.35.10</td>
<td>2.0.35.10</td>
<td>2.0.35.10</td>
<td>Native</td>
</tr>
<tr>
<td>PERC S100</td>
<td>2.0.0-0162</td>
<td>2.0.0-0162</td>
<td>2.0.0-0162</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>PERC S300</td>
<td>2.0.0-0162</td>
<td>2.0.0-0162</td>
<td>2.0.0-0162</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>PERC S110</td>
<td>3.0.0.0134</td>
<td>3.0.0.0134</td>
<td>3.0.0.0134</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>PERC H730P Adapter</td>
<td>6.600.54.00</td>
<td>6.600.54.00</td>
<td>6.600.54.00</td>
<td>6.600.54.00</td>
</tr>
<tr>
<td>PERC H730P Mini Blades</td>
<td>6.600.54.00</td>
<td>6.600.54.00</td>
<td>6.600.54.00</td>
<td>6.600.54.00</td>
</tr>
<tr>
<td>PERC H730P Mini Monolithic</td>
<td>6.600.54.00</td>
<td>6.600.54.00</td>
<td>6.600.54.00</td>
<td>6.600.54.00</td>
</tr>
<tr>
<td>PERC H730 Adapter</td>
<td>6.601.00.00</td>
<td>6.601.00.00</td>
<td>6.601.00.00</td>
<td>6.601.00.00</td>
</tr>
<tr>
<td>Controller</td>
<td>Red Hat Linux Driver 5.9</td>
<td>Red Hat Linux 6.5 Driver</td>
<td>SUSE Linux 11 SP23</td>
<td></td>
</tr>
<tr>
<td>----------------------------------</td>
<td>--------------------------</td>
<td>--------------------------</td>
<td>-------------------</td>
<td></td>
</tr>
<tr>
<td>PERC 5/E</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td></td>
</tr>
<tr>
<td>PERC 5/i Integrated</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td></td>
</tr>
<tr>
<td>PERC 5/i Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td></td>
</tr>
<tr>
<td>SAS 5/iR Integrated</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td></td>
</tr>
<tr>
<td>SAS 5/iR Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td></td>
</tr>
<tr>
<td>SAS 5/i Integrated</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td></td>
</tr>
<tr>
<td>SAS 5/E Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td></td>
</tr>
<tr>
<td>PERC 6/E Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td></td>
</tr>
<tr>
<td>PERC 6/i Integrated</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td></td>
</tr>
<tr>
<td>PERC 6/i Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td></td>
</tr>
<tr>
<td>SAS 6/iR Integrated</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td></td>
</tr>
<tr>
<td>SAS 6/iR Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td></td>
</tr>
<tr>
<td>SAS 6/iR Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td></td>
</tr>
<tr>
<td>SAS 6/int</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
<td></td>
</tr>
<tr>
<td>Modular</td>
<td>LSI 1020 on 1600SC</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td></td>
<td>LSI 1030 on Power Edge 1750</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H800 Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H700 Integrated</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H700 Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H700 Modular</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H200 Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H200 Integrated</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H200 Modular</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>6Gbps SAS HBA</td>
<td>Native</td>
<td>5.2.220.64</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H310 Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H310 Mini Monolithic</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H310 Mini Blades</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H710 Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H710 Mini Blades</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H710 Mini Monolithic</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H710P Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H710P Mini Blades</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H710P Mini Monolithic</td>
<td>Native</td>
<td>00.00.05.38</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H810 Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>Internal type Adapter</td>
<td>Native</td>
<td>5.2.220.64</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC S100</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td></td>
<td>PERC S300</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td></td>
<td>PERC S110</td>
<td>Not Supported</td>
<td>Not Supported</td>
<td>Not Supported</td>
</tr>
<tr>
<td></td>
<td>PERC H730P</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>Adapter</td>
<td>PERC H730P mini Blades</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td>---------</td>
<td>------------------------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td></td>
<td>PERC H730P mini Monolithic</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H730 Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H730 mini Blades</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H730 mini Monolithic</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H830 Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H330 Adapter</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H330 mini Blades</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H330 mini Monolithic</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
<tr>
<td></td>
<td>PERC H330 Embedded</td>
<td>Native</td>
<td>Native</td>
<td>Native</td>
</tr>
</tbody>
</table>

**Installation and Configuration Notes**

N/A

**Documentation Errata**

The following section is about documentation updates that is not available in the Server Administrator Storage Management Help/online documents.

- Under What Is New in This Release section, the following information is documented as
  - Added support for the following operating systems:
    - VMware vSphere 5.0 U3 and 5.5 – The text must be read, VMware vSphere 5.0 U3, 5.1 U2, and 5.5.
  - Added support for web browsers:
    - Google Chrome version 27, 28, 30, and 31 – The text must be read, Google Chrome, 27, 28, and 30.
- Under Enabling Cryptographic Erase On A Non-Volatile Memory Express (NVMe) PCIe SSD, the Caution related to VMware ESXi hosts is invalid, as Cryptographic Erase is not supported on VMware ESXi hosts.
- Under Adding PCIe SSDs To Fluid Cache Pool, a Note must be included stating that this task in only supported on Micron PCIe SSDs.
- 4K sector hard-disk drives must be read as 4KB sector hard-disk drives.